Communauté User Guide
Version 2.2.2
Communité Version Statement

This document describes Communité features that may not be available in your product version. This Communité version is based on the IC platform, and others may be developed:


How do I know if I have a documented feature?
If a feature is not selectable from email, phone, web browser, or personal digital assistant (PDA), then this feature is not available in your version.

If you have questions about feature availability, contact your vendor regarding the feature set available in your version of this product.
# Table of Contents

**Introduction** ........................................ 5  
**Accessing the User Tutorial** ......................... 6  
**Setting Up and Accessing Your Communité Mailbox** .... 7  
  - Setting up your mailbox ................................ 7  
  - Accessing your mailbox from inside your organization ....... 7  
  - Accessing your mailbox from outside your organization ...... 7  
  - Accessing your mailbox through the computer ............... 8  
**Managing Voice Messages** .......................... 9  
  - Managing voicemail by telephone .......................... 9  
  - Managing voicemail from your Communité Inbox ............ 14  
**Managing Faxes** ..................................... 23  
  - Managing faxes by telephone ............................. 23  
  - Managing faxes from your Communité Inbox ................ 25  
**Managing Email** .................................... 27  
**Sending Voicemail** .................................. 31  
  - Sending voicemail by telephone ........................... 31  
  - Sending voicemail from your Communité Inbox ............. 33  
**Managing Personal Options** ......................... 34  
  - Accessing the Manage Personal Options menu ............... 34  
  - Setting your status ..................................... 35  
  - Managing Follow Me ................................... 36  
  - Activating and deactivating rules ........................... 37  
  - Managing personal prompts ............................... 37  
  - Working with administrative options ....................... 38  
  - Managing deleted messages ............................. 43  
**Accessing Your Calendar** ............................ 44  
**Accessing Another Mailbox Folder** .................. 45
Introduction

Communité is a comprehensive, large-scale solution for unified communications, allowing users to retrieve email, voicemail, and faxes through an email client (e.g., Microsoft Outlook or Lotus Notes) or a touch-tone phone. Advanced features include Follow Me, presence management, call screening, rule-based call routing, and message notification.

As a Communité user, you can customize the system to meet your specific needs by creating rules to handle telephone calls, faxes, and voice messages.

You can set rules based on certain conditions, such as the originating phone number, time of day, or your availability status.

For example, you can create a “spouse” rule for calls that come from your home telephone number. You can configure this rule to use Follow Me, which will call you on your cell phone first and then dial any other phone numbers you define in your Personal Numbers.

Each rule can have its own set of actions that Communité processes, such as sending a call to voicemail, forwarding a call to another number, or even playing back a custom message using text-to-speech (TTS) to the caller.

A key feature of Communité is the telephone user interface (TUI). The interface lets you dial in and retrieve messages from any touchtone phone (see the Communité Quick Reference Guide).

You can use the telephone to play back voicemail messages, listen to email (using text-to-speech), and manage personal options.

You may also have access to Communité through your email system and/or the Communité Personal Settings web component. Ask your administrator if these features are available to you.

In this guide, each Communité feature is described in detail as you step through the Communité menus, prompts, and options. You will also learn commands and shortcuts available to you as you navigate through the system.

All Communité users have access to the telephone user interface; therefore, we describe these access methods first. If available, we describe the Communité Personal Settings web component, which you can access from the Communité icon in the Outlook bar of your Inbox, or from a standard web browser.
Accessing the User Tutorial

Before you use Communité, you must first set up your mailbox by phone or via the Personal Settings web pages. Communité provides a user tutorial to help you set it up.

This tutorial steps you through recording your name and personal greeting, and in setting up a passcode. If you don’t record a name prompt, the text to speech engine plays your name back to the caller. These steps outline the tutorial:

1. Access your mailbox:
   - Dial the voicemail system number.
   - Enter your mailbox number and passcode.
   - Enter # to complete the access code.
   Communité plays a prompt, welcoming you to the tutorial.

2. Communité prompts you to change your passcode. You must enter the passcode a second time for verification. Use a passcode only you know. A valid passcode is 1 to 10 numeric characters.
   After you set your passcode, you can change it at any time from your mailbox menu by pressing 5, then 5, and 3.

3. If you forget your passcode, your administrator can reset it. After a certain number of unsuccessful login attempts, Communité may lock your mailbox until your administrator unlocks it.

4. You can listen to or change your recorded name at any time from your mailbox menu by pressing 5, then 4.

Finally, Communité asks you to record a personalized greeting, which callers hear when you are unavailable to accept calls.

If you do not record a greeting, or if you deactivate it, Communité plays a standard system greeting.
Setting Up and Accessing Your Communité Mailbox

Before you can use Communité, you must set up your mailbox by phone or via the Personal Settings web page. Record your name and a personal greeting, and change your passcode from the default one assigned by your administrator.

To access your mailbox, dial the voicemail system number, enter your mailbox number, passcode, and #. You can also access your mailbox by dialing your phone number, then entering *, your passcode, and #.

Use a passcode only you know. Your passcode tells the system who you are, and prevents others from accessing your messages. A valid passcode is 1 to 10 numeric characters.

Setting up your mailbox

1. Access your mailbox.
   - Dial the voicemail system number.
   - Enter your mailbox number and passcode.
   - Enter # to complete the access code.

2. Change your passcode from the default passcode.

3. Record your name prompt and voicemail greeting.

4. Set up other personal options, such as forwarding and notification options.

5. After you change your passcode, disconnect, then record your name and complete personal options setup.

Accessing your mailbox from inside your organization

1. Dial the voicemail system number: ____________________________.

2. When the system greets you, enter your mailbox number and passcode, then press # to complete the access code.
   
   Example: 8007 (voicemail system), 2222 (extension), passcode, and #.

Accessing your mailbox from outside your organization

1. Dial the voicemail system number: ____________________________.

2. When the system greets you, enter your mailbox number and passcode, and press # to complete the access code.
   
   Example: 715-8007 (voicemail system), 2222 (extension), passcode, and #.
Accessing your mailbox through the computer

After you set up your mailbox by phone, you can also begin using the Communité Personal Settings web interface. You can access the web interface after running the Communité Client components on your workstation.

If you haven’t yet changed your passcode from the default one assigned by your administrator, a dialog box pops up before the Personal Settings page, asking you to change your passcode.

To open the main page, with the Outlook bar turned on, click the bee on the upper left side of your Communité Inbox.

To open the main page from a standard web browser, open the browser and navigate to your Communité web site.

Access the Communité Personal Settings web interface from your workstation.
Managing Voice Messages

This section describes many features, including listening to, saving, forwarding, replying to, and deleting voicemail. You can access these features through your telephone, or from the Communité Personal Settings web page.

You can listen to voicemail through computer speakers, a local telephone handset, or a remote telephone number. If your telephone has a message waiting indicator, you may receive visual or audio signs, such as a flashing or solid light or a stutter tone when you lift the receiver, to let you know you have new messages. These indicators will not stop until you listen to all messages.

You may not have certain options, depending on the features available in your version. See your administrator if you have questions.

Managing voicemail by telephone

On the Communité Main Menu, Manage Voice Messages is Option 1. The next options are Listen to New (1) or Saved (2) Messages.

Commands and features available at all times

At any time while the system is playing your messages, press these keys to perform these commands:

- Save current message 1
- Forward message to extension 2
- Skip to next message 3
- Replay current message 4
- Rewind current message 5
- Fast forward 6 seconds 6
- Delete this message, play next 7
- Play envelope information 8

Access your voice messages

1. Dial the Communité system number.
2. Enter your mailbox number and passcode.
3. Enter # to complete the passcode.
4. Enter 1 to manage voicemail.
5. Press 1 to listen to new messages, or press 2 to listen to saved messages.
Managing Voice Messages

Save a voicemail message

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To save the message, press 1 while listening to it, or after the system finishes playing it.

Delete a voicemail message

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To delete the current message, press 7 while listening to it, or after the system finishes playing it.

Forward a voicemail to a Communité extension

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To forward the message, press 2.

3. Enter the Communité extension to which you want to forward the message, then press #.

   - You can enter multiple extensions each followed by #, and end the list with ##.

Forward a voicemail using dial by name

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To forward the message, press 2.

3. To dial the forwarding extension by name, press 2.

Forward a voicemail and attach a voice comment

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To forward the message, press 2.

3. Enter the extension, or dial by name.

4. To record a voice comment and attach it to the original voicemail, press 2.
Forward a voicemail and set the priority

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To forward the message, press 2.

3. Enter the extension or dial by name.

4. To accept the extension, press 1.

5. To set the level of priority you wish to attach to this message (the system defaults to Normal priority):
   - For High priority, press 1
   - For Low priority, press 2
   - For Normal priority, press 3

Forward a voicemail using dial by personal group

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To forward the message, press 2.

3. To dial by personal group, press 3.

4. Enter personal group number or name.

5. To dial by group name, press 2, and enter the specified number of characters of your party’s last name. The system tells you how many to enter.

Forward a voicemail using dial by personal contact

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To forward the message, press 2.

3. To dial by personal contact, press 4.

4. Enter the specified number of characters of your party’s last name. The system tells you how many to enter.

Skip to the next voicemail

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To skip to the next voicemail, press 3.
Managing Voice Messages

Replay the voicemail

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To replay the current voicemail, press 4.

Reply to the voicemail sender

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To reply to the sender of this voicemail, press 5.

3. To call back to the sender’s number, press 1.

Reply to the voicemail using voicemail

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To reply to the sender of this voicemail, press 5.

3. To reply to the sender using voicemail, press 2.

4. Record your message then press 1 for options. Your options are:
   - To send the message, press 1.
   - To review the message, press 2.
   - To rerecord the message, press 3.

Reply to voicemail and listen to number again

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To reply to the sender of this voicemail, press 5.

3. To listen to the sender’s number again, press 3.

Reply to voicemail by calling a different number

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To reply to the sender of this voicemail, press 5.

3. To call a different number, press 4.

4. Enter the number you wish to call.
Play text in the message body of the voicemail

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To listen to the text portion of the voicemail message, press 6. The system cannot read graphics or attachments.

Delete current voicemail and play next message

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To delete the current voicemail and begin playing the next message, press 7.

Delete current voicemail and all other voicemails with the same subject

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To delete the current voicemail, press 7.

3. To delete all other voicemail messages with the same subject, press 1.

Delete current voicemail and all other voicemails addressed to the same recipient list

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To delete the current voicemail, press 7.

3. To delete all other voicemail messages addressed to the same recipient list, press 2.

Play the envelope information

1. Access your mailbox, press 1 to enter the Manage Voice Message menu, and choose 1 to listen to new messages, or choose 2 to listen to saved messages.

2. To play detailed information about the current voicemail, such as when the voicemail was sent, who sent the voicemail, and the subject of the voicemail, press 8.

† These options are silent and do not contain spoken prompts.
Managing Voice Messages

Managing voicemail from your Communité Inbox

If you have access to Communité through your email system and/or the Communité Personal Settings web component, and you use the Communité voicemail form available only to Microsoft Outlook and Lotus Notes users, you can manage voicemail from your computer.

You can listen to the message with the computer’s speakers, your telephone handset, or a remote phone number.

A voicemail message appears in your Communité Inbox as an email attachment. Communité includes details about the message, such as the name, phone number, subject, length of the message, and the time sent.

The following tasks show you how to manage voicemail from your Communité Inbox, such as listening to, forwarding, replying to, and creating voicemail messages.

In most cases, you can also perform these tasks from within the voicemail form. Simply use the menu options at the top of the voicemail form window.

The following tasks assume you use the Communité voicemail form within Outlook. For more information on using the voicemail form, see the Outlook Voicemail Form online help.
Listen to messages through your Communiqué Inbox

In Outlook, a telephone icon (📞), or an attachment icon (첨부물) will appear next to an email message that contains voicemail. To listen to the voicemail, double-click it or right-click the message and choose Open.

The figure on the right shows a typical voicemail message. Use the action buttons on the voicemail form to listen to or control the way your message is played. The message also contains information about the call.

Open your voicemail message in your Communiqué Inbox and listen to it from the voicemail form.
Managing Voice Messages

Understanding voicemail tools in Outlook

The Voice Mail menu allows you to create and send new voicemail messages, add your own voicemail message when you reply to or forward voicemail messages, and automatically place a call back to the person who left you a voicemail message. In addition, you can create and send new voicemail messages by opening the File Menu and choosing New Voice Message.

The Voice Mail menu consists of the following menu options:

- **New Voice Message ( RECORDING )**: This option opens the voicemail form, where you can record a new voicemail message.
- **Reply with VM ( RECORDING )**: The Reply to voicemail with voicemail option opens the voicemail form, where you can create and attach a text message or record and attach a voice message to send to the voicemail originator.
- **Reply to All with VM ( RECORDING )**: The Reply to all with voicemail option opens the voicemail form, where you can create and attach a text message or record and attach a voice message to send to all parties who received the original voicemail message.
- **Forward with VM ( RECORDING )**: This option opens the voicemail form, where you can create and attach a text message or record and attach a voice message to send to another recipient.
- **Live Reply ( RECORDING )**: Choose the Live Reply option to place a telephone call to the person who sent you the message, provided he or she is a Communité user.

For more information on using voicemail tools in Outlook, see the Outlook Voicemail Form online help.
Create a voice message

When you create, forward, or reply to a voicemail, you can record and attach a message from your PC with a microphone or a remote telephone number or Communité extension. You can still add text to a voicemail to which you forward or reply. You can record your message from either a microphone or handset by choosing to record from a PC microphone, a remote telephone number, your Communité extension, or another user’s Communité extension. To record a voice message:

1. In Microsoft Outlook, open the Voice Mail menu and choose to reply to, forward, or create a new voice message. The voicemail form window opens.

2. In the To and Cc boxes, add or edit the voicemail recipient names. Or to select additional recipient names from a list, click the To or Cc button.

3. In the Subject box, type or edit the topic of the message.

4. Click Record ( ), and begin recording your message into your PC microphone, or follow the prompts from your telephone handset to record your message.

5. When you finish recording your message, click Stop ( ).

6. Optionally type a message in the text box.

7. Click Send ( ).

Attach a file to the voicemail message

You can attach files to the voicemail message. The voicemail form supports adding attachments when sending (or replying to or forwarding) messages. To attach a file to a voicemail message:

1. In Microsoft Outlook, open the Voice Mail menu and choose to reply to, forward, or create a new voice message. The voicemail form window opens.

2. In the To:, Cc:, and Bcc: fields, add or edit the recipient names.

3. Click the attachment button ( ) or open the Insert menu and choose File.

4. Navigate to the file you want to send, and click Insert.

5. Optionally type a message in the body of the voicemail form.

6. Click Send ( ).
Managing Voice Messages

Reply to a voicemail using voicemail

To use voicemail to reply to a voicemail:

1. In Microsoft Outlook, open the Voice Mail menu and choose Reply with VM (Reply).

2. In the To and Cc boxes, add or edit the voicemail recipient name. Or to select additional recipient names from a list, click the To or Cc button.

3. In the Subject box, type the topic of the message.

4. Click Record (Record) to begin recording.

5. Click Stop (Stop) when you finished recording.

6. In the text box, optionally type a message.

7. Click Send (Send).

Reply to all recipients using voicemail

To use voicemail to reply to all recipients of a voicemail:

1. In Microsoft Outlook, open the Voice Mail menu and choose Reply to All with VM (Reply to All).

2. In the To and Cc boxes, add or edit the voicemail recipient names. Or to select additional recipient names from a list, click the To or Cc button.

3. In the Subject box, type the topic of the message.

4. Click Record (Record) to begin recording.

5. Click Stop (Stop) when you finished recording.

6. In the text box, optionally type a message.

7. Click Send (Send).

Return a voicemail using Live Reply

When the caller is a Communité user, or you know the caller’s telephone number, you can call that number by using Live Reply. To return a voicemail using Live Reply:

1. In Microsoft Outlook, highlight the voicemail message to which you want to reply.

2. Open the Voice Mail menu and choose Live Reply. Or to call the sender from the voicemail form window, click Live Reply (Live Reply) at the top of the window. The Return Call window opens.

3. In the Call This Number field, verify that field contains the correct telephone number, or enter the telephone number you want to call.

4. In the My Number Is field, verify that the field contains your telephone number or Communité extension.

5. Click Dial. Communité calls the voicemail sender back.
Managing Voice Messages

Forward with voicemail

To forward a voicemail and add a voicemail message:

1. In Microsoft Outlook, open the Voice Mail menu and choose Forward with VM (Forward). The voicemail window opens.

2. In the To and Cc boxes, add or edit the voicemail recipient names. Or to select additional recipient names from a list, click the To or Cc button.

3. In the Subject box, type the topic of the message.

4. Click Record (Record) to begin recording.

5. Click Stop (Stop) when you finished recording.

6. In the text box, optionally type a message.

7. Click Send (Send).

Set up playback settings for the Outlook voicemail form

The Playback Settings menu, available in the voicemail form window, displays the available devices for listening to your voicemail messages:

- **Telephone Handset**: Select this option to listen to your voicemail messages through the phone connected to your computer. If you are logged into more than one station, you must choose from a list of stations each time you open a message. When you use the Telephone Handset option, you do not have control of the volume, position (rewind/fast-forward), and speed slider bars.

- **PC Speaker**: Select this option to listen to your voicemail messages through the speakers connected to your computer. When using the PC Speaker option you have the full control of the volume, position (rewind/fast-forward), and speed slider bars.

- **Remote Telephone**: Select this option to listen to your voicemail messages from a remote location. When using the Remote Telephone option, you do not have control of the volume, position (rewind/fast-forward), and speed slider bars. After listening to your voicemail messages using the Remote Telephone device, you must manually hang up to end the connection. Otherwise, you stay connected.

- **Set Remote Number**: When you choose this option, you can enter the remote telephone number of the location to which you want to connect.
Managing Voice Messages

Set your remote telephone number

Use this option to set the remote number device within the voicemail form. To set your remote number:

1. In the voicemail form window, open the Playback Settings menu and choose Set Remote Number. The Enter Remote Number dialog box opens.

2. In the For this message use: box, enter the remote telephone number of the location to which you want to connect.

3. Click OK.
Working with voicemail in Lotus Notes

In the Lotus Notes voicemail form, you can listen to, rewind, and fast-forward voicemail messages. You can listen to the message with the computer’s speakers, your telephone handset, or a remote phone number.

The following tasks show how you can manage voicemail messages from within the Lotus Notes voicemail form.

For information on forwarding or replying to messages you receive in Lotus Notes, see the Lotus Notes online help.

For information on working with voicemail messages in Lotus Notes, see the Lotus Notes Voicemail Form online help.

Set up playback settings for the Lotus Notes voicemail form

The Device menu, available from the View menu in the voicemail form window, displays the available playback settings devices for listening to your voicemail messages:

- **PC Speakers**: Select this option to listen to your voicemail messages through the speakers connected to your computer. When using the PC Speaker option you have the full control of the volume and the rewind/fast-forward slider bar. The position time of the message is also displayed.

- **Handset**: Select this option to listen to your voicemail messages through the phone connected to your computer. When using the Station Handset option you have the full control of the volume, but you do not have control of the rewind/fast-forward slider bar.

- **Remote Number**: Select this option to listen to your voicemail messages from a remote location. When using the Remote Number option you do not have control of the volume or the rewind/fast-forward slider bar.

Set your remote telephone number

Use this option to set the remote number device within the voicemail form. To set your remote number:

1. In the voicemail form window, open the **File** menu and choose **Set Remote Number**. The **Enter Remote Number** dialog box opens.

2. In the **Number** box, enter the remote telephone number of the location to which you want to connect.

3. Click **OK**.
Managing Voice Messages

Set the voicemail form to appear in front of other windows

Choose this option if you want the voicemail form to appear on top of any other application you are running when you open a voicemail.

In the voicemail form window, open the View menu and choose Always On Top. When this option is on, a checkmark appears next to the selection in the View menu.

Recycle Player Windows

Choose this option if you do not want to open a new voicemail window for each voicemail message you open.

In the voicemail form window, open the View menu and choose Recycle Player Windows. When this option is on, a checkmark appears next to the selection in the View menu.

Each new voicemail message you open will play in the same voicemail window. When this option is on, a checkmark appears next to Recycle Player Windows.

Turn this option off if you want to open a separate voicemail window for each voicemail message. When this option is off, no checkmark appears next to Recycle Player Windows.

Extinguish Message Waiting Indicator

Choose this option to turn off the Message Waiting Indicator.

In the voicemail form window, open the View menu and choose Extinguish Message Waiting Indicator. When this option is on, a checkmark appears next to the selection in the View menu.

Each time you select this option, the voicemail form directs the IC server to turn off the Message Waiting Indicator, regardless of the number of unread messages in your Inbox.
Managing Faxes

This section describes many fax management features including receiving, saving, and deleting faxes. You can access these fax features from your telephone, or from the Communité Personal Settings web page.

You may not have certain options, depending on the features available in your version. See your administrator if you have questions about certain options.

Managing faxes by telephone

On the Communité Main Menu, Manage Faxes is Option 2. The next options are Receive New (1) or Saved (2) Faxes.

Commands and features available at all times

At any time while the system is playing your messages back, you can press these keys to perform the following commands:

- Save current message 1
- Skip to next message 3
- Replay current message 4
- Delete this message, play next 7
- Play envelope information 8

Access your faxes

1. Dial the Communité system number.
2. Enter your mailbox number and passcode.
3. Enter # to complete the passcode.
4. Enter 2 to manage faxes.
5. Press 1 to listen to new faxes, or press 2 to listen to saved faxes.

Save a fax

1. Access your mailbox, press 2 to enter the Manage Faxes menu, and choose 1 to listen to new faxes, or choose 2 to listen to saved faxes.
2. To save the fax, press 1.
Managing Faxes

Skip to the next fax

1. Access your mailbox, press 2 to enter the Manage Faxes menu, and choose 1 to listen to new faxes, or choose 2 to listen to saved faxes.

2. To skip to the next fax, press 3.

Receive the current fax

1. Access your mailbox, press 2 to enter the Manage Faxes menu, and choose 1 to listen to new faxes, or choose 2 to listen to saved faxes.

2. To receive the current fax, press 4.

3. Enter the phone number of the fax machine at which you want to receive the fax, followed by #.

Delete a fax

1. Access your mailbox, press 2 to enter the Manage Faxes menu, and choose 1 to listen to new faxes, or choose 2 to listen to saved faxes.

2. To delete a fax, press 7.

Delete the current fax and all other faxes with the same subject

1. Access your mailbox, press 2 to enter the Manage Faxes menu, and choose 1 to listen to new faxes, or choose 2 to listen to saved faxes.

2. To delete the current fax, press 7.

3. To delete all other faxes with the same subject, press 1.†

Delete the current fax and all other faxes addressed to the same recipient list

1. Access your mailbox, press 2 to enter the Manage Faxes menu, and choose 1 to listen to new faxes, or choose 2 to listen to saved faxes.

2. To delete the current fax, press 7.

3. To delete all other faxes addressed to the same recipient list, press 2.†

Play envelope information

1. Access your mailbox, press 2 to enter the Manage Faxes menu, and choose 1 to listen to new faxes, or choose 2 to listen to saved faxes.

2. To play detailed information about the current fax message, such as when the fax was sent, who sent the fax, and the subject of the fax, press 8.

† These options are silent and do not contain spoken prompts.
Managing faxes from your Communité Inbox

You can manage faxes through your Communité Inbox. Ask your administrator if this feature is available.

Because your fax appears in your email Inbox, you can manage a fax much in the same way as an email message.

You can perform such tasks as deleting, setting a priority.

Forward a fax by email and set the priority

1. Open your desktop email client and double-click the email containing the fax.
2. Select Forward and choose an email recipient. In this example, the email priority is set to high.

You can forward a fax through your Communité Inbox and set the priority.
Reply to the fax

1. Open your desktop email client and double-click the fax message to open it.
2. From the menu, choose Actions and then choose Reply.
3. Change the To: field to reflect the recipients email address. The email form attaches the fax to the message.
4. Type your message to the recipient.
5. Click Send.

Forward faxes to other email recipients

1. Open your desktop email client and double-click the fax message to open it.
2. Click Forward to open the email form. The email form attaches the fax to the message.
3. Enter the recipients’ names.
4. Click Send.
Managing Email

This section describes many features including listening to, saving, forwarding, replying to, and deleting email. You can access these email features from the telephone, or from the Communité Personal Settings web page.

On the Communité Main Menu, Manage Email is Option 3. The next options are Listen to New (1) or Saved (2) Email.

You may not have certain options, depending on the features available in your version. See your administrator if you have questions about certain options.

 Commands and features available at all times

At any time while the system is playing your messages, you can press these keys to perform the following commands:

- Save current message: 1
- Forward message to extension: 2
- Skip to next message: 3
- Replay current message: 4
- Rewind current message: 5
- Fast forward 6 seconds: 6
- Delete this message, play next: 7
- Play envelope information: 8

Access your email

1. Dial the Communité system number.
2. Enter your mailbox number and passcode.
3. Enter # to complete the passcode.
4. Press 3 to manage email.
5. Press 1 to listen to new email, or press 2 to listen to saved email.

Save an email message

1. Access your mailbox, press 3 to enter the Manage Email menu, and choose 1 to listen to new email, or choose 2 to listen to saved email.
2. To save the email, press 1 while listening to the email message or after the system finishes playing it.
Delete an email message

1. Access your mailbox, press 3 to enter the Manage Email menu, and choose 1 to listen to new email, or choose 2 to listen to saved email.

2. While listening to the email message or after the system finishes playing it, press 7.

Forward an email to an extension

1. Access your mailbox, press 3 to enter the Manage Email menu, and choose 1 to listen to new email, or choose 2 to listen to saved email.

2. To forward the email, press 2.

3. Enter the Communité extension followed by #. You can enter multiple extensions each followed by #, and end the list by ##.

Forward an email using dial by name

1. Access your mailbox, press 3 to enter the Manage Email menu, and choose 1 to listen to new email, or choose 2 to listen to saved email.

2. To forward the email, press 2.

3. To dial by name, press 2.

Forward an email using dial by personal group

1. Access your mailbox, press 3 to enter the Manage Email menu, and choose 1 to listen to new email, or choose 2 to listen to saved email.

2. To forward the email, press 2.

3. To dial by personal group, press 3.

4. Enter the personal group number or name.

5. To dial by group name, press 2, and enter the specified number of characters of your party's last name. The system tells you how many to enter.

Forward an email using dial by personal contact

1. Access your mailbox, press 3 to enter the Manage Email menu, and choose 1 to listen to new email, or choose 2 to listen to saved email.

2. To forward the email, press 2.

3. To dial by personal contact, press 4.

4. Enter the specified number of characters of your party's last name. The system tells you how many to enter.
### Forward an email and set the priority

1. Access your mailbox, press **3** to enter the Manage Email menu, and choose **1** to listen to new email, or choose **2** to listen to saved email.

2. To forward the email, press **2**.

3. Enter the extension, or dial by name.

4. To send the message now, press **1**.

5. Set the level of priority for this message (the system defaults to Normal priority):
   - For High priority, press **1**
   - For Low priority, press **2**
   - For Normal priority, press **3**

### Forward an email and attach a voice comment

1. Access your mailbox, press **3** to enter the Manage Email menu, and choose **1** to listen to new email, or choose **2** to listen to saved email.

2. To forward the email, press **2**.

3. Enter the extension, or dial by name.

4. To record a voice message and attach it to the original email, press **2**.

### Skip to the next email

1. Access your mailbox, press **3** to enter the Manage Email menu, and choose **1** to listen to new email, or choose **2** to listen to saved email.

2. To skip to the next email, press **3**.

### Replay the current email

1. Access your mailbox, press **3** to enter the Manage Email menu, and choose **1** to listen to new email, or choose **2** to listen to saved email.

2. To replay the current email, press **4**.

### Reply to the current email using voicemail

1. Access your mailbox, press **3** to enter the Manage Email menu, and choose **1** to listen to new email, or choose **2** to listen to saved email.

2. To reply to the email sender, press **5**.

3. Record your message and press **1** for these options:
   - To send the message, press **1**.
   - To review the message, press **2**.
   - To rerecord the message, press **3**.
   - To set delivery priority, press **4**.
   - To cancel and return, press *.
Managing Email

Play text in the message body of the email

1. Access your mailbox, press 3 to enter the Manage Email menu, and choose 1 to listen to new email, or choose 2 to listen to saved email.

2. To listen to the text portion of the email message, press 6. The system cannot read graphics or attachments.

Delete the email and play the next message

1. Access your mailbox, press 3 to enter the Manage Email menu, and choose 1 to listen to new email, or choose 2 to listen to saved email.

2. To delete the current email and begin playing the next message, press 7.

Delete the current email and all other messages with the same subject

1. Access your mailbox, press 3 to enter the Manage Email menu, and choose 1 to listen to new email, or choose 2 to listen to saved email.

2. To delete the current email, press 7.

3. To delete all other email messages with the same subject, press 1.†

Delete the current email and all other emails addressed to the same recipient list

1. Access your mailbox, press 3 to enter the Manage Email menu, and choose 1 to listen to new email, or choose 2 to listen to saved email.

2. To delete the current email, press 7.

3. To delete all other email messages addressed to the same recipient list, press 2.†

Play the envelope information

1. Access your mailbox, press 3 to enter the Manage Email menu, and choose 1 to listen to new email, or choose 2 to listen to saved email.

2. To play detailed information about the current email message, such as when the email was sent, who sent the email, and the subject of the email, press 8.

† These options are silent and do not contain spoken prompts.
Sending Voicemail

Communité lets you record voicemail messages for other Communité users or external callers. If you call a user’s extension and the call is unanswered (the user is on the phone, or the extension is forwarded to voicemail), you can leave a voicemail. You can also leave a voicemail without speaking to the user.

Communité retrieves caller identification information, if it is available from the White Pages file, and includes it in the voicemail form. This allows you to see immediately who left a voicemail message.

Sending voicemail by telephone

On the Communité Main Menu, Send Voicemail is Option 4.

You may not have certain options, depending on the features available in your version. See your administrator if you have questions about certain options.

Access the Send Voicemail menu

1. Dial the Communité system number.
2. Enter your mailbox number and passcode.
3. Enter # to complete the passcode.
4. Enter 4 to send voicemail.

Create a voicemail and send to one or more extensions

1. Access your mailbox and press 4 to enter the Send Voicemail menu.
2. To dial by name, press 2.
3. Enter the Communité extension followed by #. Enter multiple extensions each followed by #, and end the list by ##.
4. Record your message then press 1 for these options:
   - To send the message, press 1.
   - To review the message, press 2.
   - To rerecord the message, press 3.
   - To set delivery priority, press 4.
   - To cancel and return, press *.
5. Optionally set the level of priority for your message (the system defaults to Normal priority):
   - For High priority, press 1
   - For Low priority, press 2
   - For Normal priority, press 3
Sending Voicemail

Create a voicemail and send it to a personal group

1. Access your mailbox and press 4 to enter the Send Voicemail menu.
2. To dial by personal group, press 3.
3. Enter the personal group extension followed by #. Enter multiple extensions each followed by #, and end the list by ##.
4. To dial by group name, press 2, and enter the specified number of characters of your party’s last name. The system tells you how many to enter.

Communité prompts you if more than one group with the same number exists.

For example, if Sales-East and Sales-West share the same group number, you will hear this prompt: “Several groups match that entry. To select Sales-East, press 1. To select Sales-West, press 2.”

Create voicemail and send it to personal contacts

1. Access your mailbox and press 4 to enter the Send Voicemail menu.
2. To dial by personal contact, press 4.
3. Enter the specified number of characters of your party’s last name. The system tells you how many to enter. You can enter multiple extensions each followed by #, and end the list by ##.

Communité prompts you if multiple matches for personal contacts exist. You will hear a list of people who have the same names and can choose from the available options.

For example, if two contacts have Smith as a last name, you will hear “Several people match that entry, for Sue Smith, press 1, for Doug Smith, press 2.”
Sending voicemail from your Communité Inbox

If you have access to Communité through your email system and/or the Communité Personal Settings web component, and you use the Communité voicemail form available only to Microsoft Outlook and Lotus Notes users, you can send voicemail from your computer.

For more information on available voicemail tasks you can perform from your Communité Inbox, see Managing voicemail from your Communité Inbox on page 14.
Managing Personal Options

This section describes many features including setting your user status, setting a forwarding fax number, changing your passcode, setting playback options, and managing many other options.

You can access these features from your telephone, or from the Communité Personal Settings web page. For a quick reference list of the available options on the Manage Deleted Messages sub-menu, see the Communité Quick Reference Guide.

Managing personal options by telephone

On the Manage Personal Options is Option 5. Six sub-menus exist under Option 5 on the telephone user interface:

- Set User Status 1
- Manage Follow Me 2
- Activate and Deactivate Rules 3
- Manage Personal Prompts 4
- Administrative Options 5
- Manage Deleted Messages 7

Accessing the Manage Personal Options menu

1. Dial the Communité system number.
2. Enter your mailbox number and passcode.
3. Enter # to complete the passcode.
4. Enter 5 to manage personal options.
Setting your status

The first sub-menu under Manage Personal Options is Option 1, Set User Status.

1. Access your mailbox and press 5 to enter the Manage Personal Options menu.

2. Press 1 to set your status.

3. Press the number that corresponds with your status.

Depending on the status you choose, you may have the option to set the date, time or both.

Some statuses also offer the Until Date. If the date and/or time exceeds the time you specify in the Until field, Communité will not play the date and time to the caller when it plays your status.

Choose from the following available status types:

- Available 1
- At Lunch 2
- Away from Desk 3
- Do Not Disturb 4
- Gone Home 5
- In a Meeting 6
- On Vacation 7
- Out of the Office 8
- Out of Town 9
- Working at Home 10
Managing Personal Options

Managing Follow Me

The second sub-menu under Manage Personal Options is Option 2, Manage Follow Me.

Communité uses the Follow Me feature to route your calls to you at a number or numbers that you specify, depending on your status. Follow Me numbers are associated with your availability status.

If you change your status, you can direct calls to follow you to a phone number or a series of phone numbers you specify in the Follow Me Settings area of the Communité Settings web page. You manage these phone numbers over the telephone or through the Communité Personal Settings page.

This section shows you the options available to manage the Follow Me feature over the phone, and later you’ll see how to manage these options over the Web.

Set up Follow Me Routing

1. Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 2 to manage Follow Me.

2. Choose from these options:
   - Turn Follow Me routing on or off
   - Listen to current configuration options
   - Add a telephone number
   - Edit a telephone number
   - Delete a telephone number
   - Activate or deactivate Call screening

   When entering a Follow Me number for the first time, (option 3) you must toggle Follow Me on and off by pressing 1. The system will tell you that you must have at least one telephone number configured for Follow Me to work. If the number already exists in the Personal Numbers list, the system will prompt you for the remote number and will use that number for Follow Me.

   If that number does not exist, it gets added to the Personal Numbers list and you have to toggle Follow Me off and on by pressing 1. Then you select that number for Follow Me.

3. If you choose Option 3, add a telephone number:
   - Enter telephone number.
   - Enter the number of seconds you want the system to alert the entry.
   - To turn passcode verification on, press 1, or to turn it off, press 2.
Activating and deactivating rules

The third sub-menu under Manage Personal Options is Option 3, Activate and Deactivate Rules. You can listen to and turn on or off the call, fax, and voice interaction rules you have set up in the Communité Personal Settings page. The next section covers these personal settings features.

1. Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 3 to activate or deactivate your rules.

2. Press 1 while listening to a rule to turn it on or off.

Managing personal prompts

The fourth sub-menu under Manage Personal Options is Option 4, Manage Personal Prompts. You can record your voicemail greeting and name prompt, and turn your prompt on and off through this sub-menu.

1. Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 4 to manage your personal prompts.

2. Choose from these personal prompt features:
   - Record voicemail greeting 1
   - Listen to your voicemail greeting 2
   - Record your name 5
   - Listen to your name prompt 6
   - Toggle greeting on or off 9

You will only hear Options 2, 6, and 9 if the prompt exists, which means you have already recorded a prompt.

While you are in this sub-menu, you can jump between the options. For example, you may wish to record your name (press 5), and then listen to your name prompt (press 6).

When recording greetings, you should include the options available to the caller, such as, “Press 6 to send a fax”. 
Managing Personal Options

Working with administrative options

The fifth sub-menu under Manage Personal Options is Option 5, Administrative Options. You can manage your personal groups, set fax options, change your passcode, and other options. Five options are available to you:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 5 to manage Administrative options.</td>
</tr>
<tr>
<td>2</td>
<td>To manage personal groups, press 1.</td>
</tr>
<tr>
<td>3</td>
<td>To review personal groups, press 1.</td>
</tr>
<tr>
<td>4</td>
<td>To add a new personal group, press 2.</td>
</tr>
<tr>
<td>5</td>
<td>To delete a personal group, press 3.</td>
</tr>
</tbody>
</table>

Fax Options

1. Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 5 to manage Administrative options.

2. To set your fax options, press 2.

3. To enter the number where you wish to forward your incoming faxes, press 1. Communité will prompt you for the fax number.

4. To turn the fax-forwarding feature on, press 2. To turn fax forwarding off, press 2 again. This feature acts as a toggle switch.
**Change your Communité passcode**

1. Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 5 to manage Administrative options.

2. To change your passcode, press 3.

3. Enter your old passcode.

4. Enter your new passcode followed by #. A valid passcode is 1 to 10 numeric characters.

5. Enter your new passcode once more to confirm.

**Set message playback options**

1. Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 5 to manage Administrative options.

2. To set your playback options, press 4.

3. To set the message playback mode, press 1.

4. For verbose mode, press 1, or for brief mode, press 2.

   In verbose mode, typically recommended for the inexperienced user or the user who doesn’t use the telephone interface as often, you receive more spoken prompts from the system.

   In brief mode, recommended for the user experienced with the telephone interface, you receive less prompting from the system.

**Sort messages**

1. Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 5 to manage Administrative options.

2. To set your playback options press 4.

3. To sort your messages press 2.

4. For oldest first press 1, or for newest first, press 2.
Managing Personal Options

Play high priority messages

1. Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 5 to manage Administrative options.

2. To set your playback options, press 4.

3. To play high priority messages first, press 3.

4. To activate, press 1, or to deactivate, press 2.

Play mailbox greeting

1. Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 5 to manage Administrative options.

2. To hear playback options, press 4.

3. To play the mailbox extension greeting, press 4.

4. To activate, press 1, or to deactivate, press 2.

Configure available message types

This option turns off the series of prompts associated with a message type such as email. The feature does not prevent you from listening to messages of that type when the prompts are turned off.

1. Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 5 to manage Administrative options.

2. To set your playback options, press 4.

3. To configure available message types, press 6.

4. For voicemail, press 1; for fax, press 2; or for email, press 3.

5. To activate, press 1, or to deactivate, press 2.
Configure available saved message types

1. Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 5 to manage Administrative options.

2. To set your playback options, press 4.

3. To configure available saved message types, press 7.

4. For voicemail, press 1; for fax, press 2; or for email, press 3.

5. To activate, press 1, or to deactivate, press 2.

Set Personal Notification Options

Setting these options defines the way the system notifies you when you receive a voicemail or fax.

1. Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 5 to manage Administrative options.

2. To set personal notification options, press 5.

3. Choose which notification option you want to define:
   - To change notification methods, press 1.
   - To change notification reasons, press 2.
   - To change your notification schedule, press 3.
   - To set up your notification phone number, press 4.

Change notification methods

1. Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 5 to manage Administrative options.

2. To set personal notification options, press 5.

3. To change the way you wish to be notified, press 1.

4. To turn notifications off, press 1; to be notified by pager, press 2; to be notified by phone, press 3. By default, the system leaves notifications off.
Managing Personal Options

Change notification reasons

1. Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 5 to manage Administrative options.
2. To set personal notification options, press 5.
3. To change the reason you are notified, press 2.
4. To turn on notifications for new voicemail messages, press 1. To turn on notifications for new faxes, press 2.

Change notification schedule

1. Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 5 to manage Administrative options.
2. To set personal notification options, press 5.
3. To change your notification schedule, press 3.
4. To schedule notifications at all times, press 1; to schedule notifications in a range, press 2; or to set a specific schedule for notifications, press 3.
5. If you press 2 or 3 to set your schedule, you must enter the start and end times for your notifications in military time. (For example - 13:00=1:00 p.m.)

Set your notification phone number

1. Access your mailbox, press 5 to enter the Manage Personal Options menu, and press 5 to manage Administrative options.
2. To set personal notification options, press 5.
3. To change your notification telephone number, press 4.
4. Enter your remote telephone number.
Managing deleted messages

The next sub-menu under Manage Personal Options is Option 7, Manage Deleted Messages. You can manage deleted voicemail, faxes, and email through this sub-menu.

The features on this sub-menu work much in the same way as working with new or saved messages. The options available are almost identical with only a few options removed. To verify the available options on the Manage Deleted Messages sub-menu, see the Communité Quick Reference Guide.
Accessing Your Calendar

You can use Communità to gain access to your Calendar. This section describes how to retrieve a list of appointments you set in your email client (e.g. Outlook) calendar via the telephone.

On the Communità Main Menu, Calendar Access is Option 6. Next, you can choose to listen to appointments for the current date, or you can choose to listen to appointments for a specific date.

You may not have these options, depending on the features available in your version. Calendar access is limited to Exchange and iPlanet users. See your administrator if you have questions about certain options.

Listen to appointments

1. Dial the Communità system number.
2. Enter your mailbox number and passcode, followed by #.
3. To access your calendar, press 6.
4. To listen to today's appointments, press 1 followed by #.
5. To listen to appointments for a specific date, enter the two-digit month, the two-digit date, and the two-digit year.
Accessing Another Mailbox Folder

This feature allows you to call the system via telephone and gain access to other Inbox subfolders. By default, your Inbox is always opened upon entering the system. When you press 8 from the main menu, Communité queries all subfolders in your Inbox and creates a dynamic menu for these subfolders.

Communité also creates menu options to access Sent Items and Deleted Items. These options are created after Communité creates menu options for the other Inbox subfolders.

The menu options may vary, depending on the number of subfolders created below your Inbox folder. You can press 0 at any time to return to the Inbox.

For example, assume you have three subfolders beneath your Inbox: Administration, Personal, and Support.

After you press 8 from the main menu, Communité presents you with the following dynamic menu:

<table>
<thead>
<tr>
<th>Administration</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Personal</td>
<td>2</td>
</tr>
<tr>
<td>Support</td>
<td>3</td>
</tr>
<tr>
<td>Sent Items</td>
<td>4</td>
</tr>
<tr>
<td>Deleted Items</td>
<td>5</td>
</tr>
<tr>
<td>Return to Inbox</td>
<td>6</td>
</tr>
</tbody>
</table>

You can follow these prompts to access your custom subfolders, Sent Items folder, or Deleted Items folder.
Placing a Call

This section describes how to use Communité to place telephone calls. Communité can dial a telephone number you specify, and can look up and dial a telephone number it retrieves from a list of Communité users or your personal contacts.

On the Communité Main Menu, Place a Call is Option 9. Next, you can enter the telephone number to call, or you can choose to dial by name or by personal contact.

You may not have certain options, depending on the features available in your version. See your administrator if you have questions about certain options.

Place a call

1. Dial the Communité system number.

2. Enter your mailbox number and passcode, followed by # to complete the passcode.

3. To place a call, enter 9 and then enter the telephone number you want to call, followed by #.

4. To dial by name, press 2, then follow the system instructions on how to enter your party’s last name. The system will prompt you with the number of characters to enter.

5. To dial by personal contact, press 4, then follow the system instructions on how to enter your party’s last name. The system will prompt you with the number of characters to enter.
Understanding Shared Mailboxes

The shared mailbox features allows Communité users who share the same telephone number to also share a common extension, yet each user still has their own private mailbox for voicemail, faxes, and email.

In Communité, up to nine mailboxes can be associated with one extension. Shared mailboxes and normal mailboxes will reside together on the same system. However, if the shared mailbox feature is not enabled, callers won’t be prompted to enter a shared mailbox extension.

This feature is helpful for businesses or companies whose organization dictates that employees share a common telephone number.

For example, let’s assume the shared mailbox feature is in place at a large university. Instead of assigning one extension for each student, the Communité administrator associates one extension to a dorm room and then designates multiple mailboxes for that extension.

Now, if someone calls into the university and dials the dorm room’s extension, Communité prompts the caller to, "press 1 to leave a message for student A, press 2 to leave a message for student B, press 3 to leave a message for student C" and so on.

When a student dials in to check messages, the system asks him or her to enter the appropriate extension. The student enters the dorm room’s extension, even though other roommates share it, and then enters the mailbox number associated with that student (dialing 1 for student A, 2 for student B, 3 for student C, and so on).

Next, Communité prompts them to enter the appropriate password, and then replays his or her messages.

Your Communité administrator grants permissions and options to use the shared mailbox feature. If you have questions, or need further information about shared mailboxes, see your administrator.
Managing your Personal Settings

This section lists the features available to you through the Communité Personal Settings web interface shown on the right.

From this interface, you can change your user status, change your profile and phone numbers, activate call screening, manage Follow Me, create and view personal groups, change your passcode, and manage your interaction rules.

For more information on how to use the Communité Personal Settings, click the help link.

The main page of Communité Personal Settings Web interface shows you the many available features.
Setting your status

Setting your status allows you to control how Communité handles your calls. You can change your status from the main Communité Personal Settings page.

Set your status from the Personal Settings page

To set your status without setting an end date and/or time for the status:

1. Open the Communité Personal Settings page.
2. Click the arrow at the end of the **Your status is** drop down menu and choose your status.

To set the status and set an end date or time for the status:

1. Open the Communité Personal Settings page, click the arrow at the end of the **Your status is** drop down menu and choose the appropriate Until status from the list in Table 1. The **Until** button appears next to the **Your status is** menu.
2. Click **Until**. The **Status Until Settings** window opens.
3. If available, place a checkmark in the **Date** box and use the drop down menus next to the checkbox to choose your return date.
4. If available, place a checkmark in the **Time** box and use the drop down menus next to the checkbox to choose your return time.
5. Click **Save** to save your settings and return to the Personal Settings home page.

---

### Table 1. Until statuses

<table>
<thead>
<tr>
<th>Status</th>
<th>Date</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available</td>
<td></td>
<td></td>
</tr>
<tr>
<td>At Lunch</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Away from desk</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Do Not Disturb</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gone Home</td>
<td></td>
<td></td>
</tr>
<tr>
<td>In a Meeting</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>On Vacation</td>
<td>X</td>
<td></td>
</tr>
<tr>
<td>Out of the Office</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Out of Town</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Working at Home</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

### Set your status and specify a return date and time

Some statuses let you specify an end date and/or time. The following table lists the status name and whether or not you can configure date, time, or both for each status:
Creating and managing interaction rules

Rules are special exceptions you can use to personalize your account and make yourself available to receive various interactions.

You can manage Communité Rules from the Personal Settings home page, as shown on page 48. Here, you can create personalized rules to apply to incoming calls, based on your Communité status.

Understanding Interaction Rules

You can create rules for incoming calls based on the status you set in Communité. You can also set personalized rules for different types of interactions including inbound calls, voice messages, and faxes.

Communité handles interactions based on the way you have set up rules, and the system applies the rules in the order in which they are listed on the rules page.

If you do not have a rule set up for handling a particular incoming call, the default for every status is to play your voicemail greeting, if you have recorded and activated one.

The name prompt will either play back using the text-to-speech (TTS) engine or in your voice.

When recording greetings, you should include the options available to the caller, such as to press 6 to send a fax, etc.

Create an incoming call rule based on your current status

1. Open the Communité Personal Settings page.
2. In the Rules area, click Status Rule.
3. Set up the status rule:
   - Click the drop down menu next to the When my Status is field and choose the status for which you want to create the rule.
   - Place a checkmark in the Routing Action box and then click the radio button next to the routing action you want Communité to perform for this status. The system defaults to no routing actions.
   - If you chose a Forward routing action, use the drop down menu next to it to choose to forward the incoming call to a personal number, contact, or other number.
To receive a notification message when the rule is activated, place a checkmark in the Notify box and type the telephone number or email address to which you want Communità to send the notification.

To direct Communità to read a personal reply to the caller, place a checkmark in the Auto Reply with Text to Speech box and in the field below it type the message you want the caller to hear.

To begin using the rule immediately, place a checkmark in the Enabled box.

Click Save to return to the Personal Settings home page.
Create a personalized rule for incoming calls, voicemails, or faxes

1. Open the Communité Personal Settings page.

2. In the Rules area, click Create Rule.

3. Choose the type of rule you want to create:
   - In the Rule Name field, type a unique name for the new rule, such as Spouse.
   - In the Rule Type area, click to choose an Inbound Call Rule, a Fax Rule, or a Voicemail Rule.

4. In the Conditions area, select the Conditions you want the rule to have:
   - To match all conditions, place a checkmark in the Match All Calls box, Match All Faxes box, or Match All Voicemails, depending on the rule type you choose. Communité automatically processes the actions for this rule; you do not have to set any other conditions.
   - Optionally place a checkmark in the From Phone Number box and type the incoming telephone number for which you want to apply this rule. Separate multiple numbers with commas.
   - Wildcards (* and ?) are also valid. For example, 317 555* matches all numbers beginning with 317-555, and 123? matches 1230, 1231, 1232, etc.

5. In the Routing Actions area, select the Actions you want the rule to have. Actions determine how the interaction will be handled when it meets the conditions you defined:
   - If available, optionally place a checkmark in the From Personal Number box and use the drop down menu to choose a predefined contact number to which this rule will apply.
   - Optionally place a checkmark in the From Contact box and choose a predefined contact name for which you want this rule to apply.
   - Optionally place a checkmark in the My Status box and use the drop down menu to choose the status to which this rule will apply.
   - Optionally place a checkmark in the Date Range box and use the drop down menus to choose a rule start and end date.
   - Optionally place a checkmark in the Time Range box and choose a rule start and end time.
• Place a checkmark in the **Routing Action** box and then click the radio button next to the routing action you want Communité to perform for this status. The system defaults to no routing actions.

• If you chose a **Forward** or **Send copy to** routing action, use the drop down menu next to it to choose to forward the incoming call to a personal number, contact, or other number, or to send a copy to a contact’s email or other email address.

  **Note**: The **Send copy to** routing action is used only for voicemail rules.

• To receive a notification message when this rule is executed, place a checkmark in the **Notify** box and type the telephone number or email address to which you want Communité to send the notification.

• To direct Communité to read a personal reply to the caller, place a checkmark in the **Auto Reply with Text to Speech** box and in the field below it type the message you want the caller to hear.

• To direct Communité to not process any other rules, place a checkmark in the **Stop processing more rules** box. If you check this box, Communité will not process another rule, even if this interaction matches more than one rule you set.

• To direct Communité to not process any other rules, place a checkmark in the **Stop processing more rules** box. If you check this box, Communité will not process another rule, even if this interaction matches more than one rule you set.

• To activate the rule, place a checkmark in the **Enabled** box at the top of the window.

• Click **Save** to add the new rule.

---

**Change the order of your personalized rules**

You can reorder inbound call rules, fax rules, and voicemail rules from this page.

1. Open the Communité Personal Settings page.

2. In the **Rules** area, click **Re-order Rules**.

3. To change Inbound Call, Fax, or Voicemail rules order, highlight the rule you want to move and use the Up and Down arrows to change the order.

4. Click **Finished**.
Managing your Personal Settings

Edit or delete a personalized rule

1. Open the Communité Personal Settings page.

2. To delete a personalized rule, in the Rules area click the Delete link next to the rule you want to delete.

3. To edit a personalized rule, in the Rules area click the Edit link next to the rule you want to modify, and make your changes.
Creating and managing groups

If you send messages to the same group of Communité users and/or personal contacts regularly, personal groups can save time. You create the groups by assigning as many Communité users and/or personal contacts as you desire to a group extension. Communité personal groups help you:

- Create personalized groups of Communité users and personal contacts in order to broadcast voice messages to these people.
- View the statuses of the Communité users associated to your groups.

The figure on the right illustrates an example of personal groups and personal contacts located on the Address Book page.

From the Address Book, you can create, edit, manage, and remove your personal groups and personal contacts.
Managing your Personal Settings

Using Personal Groups

From the Communité Personal Settings web page, you can create, edit, and remove your personal groups. From the telephone, you are able to broadcast a message to a group, where the message is sent to all members of the group.

The Communité Personal Settings page provides a quick view of your personal groups.

1. Open the Communité Personal Settings page.
2. Click the Address Book link at the top of the Personal Settings page.
3. Click a personal group to view the name and extension of the group and all associated members and their statuses.

Create a Personal Group

1. Open the Communité Personal Settings page.
2. Click the Address Book link at the top of the Personal Settings page.
3. To add a personal group:
   • In the Personal Groups area, click Create.
   • In the Group Name field, type a name for your personal group.
   • In the Group Number field, add a number for your personal group.

   The Group Number is used from the telephone user interface to select personal groups. Providing a group number makes it easier to forward voicemails, faxes, and emails to personal groups.

4. To add contacts or other Communité users to the Personal Group:
   • Click Add Members to search for the Communité Users and personal contacts you want to be members of this group.
   • To search for specific members, enter the first name, last name, phone number, fax number, or email address of the personal contact you wish to add and click Search.
   • To add Communité Users with a specific status, place a checkmark in the Status box, use the drop down menu to choose the status whose members you want to find, then click Search.
   • Highlight the contacts you want to add and use the arrows between the Found and Add areas to add or remove users.

5. Click Finished to add the contacts to your personal group and return to the Address Book.
View a personal contact’s properties

From the Address Book page, you can highlight a personal group to view Group Members, and their properties.

Edit a Personal Group

1. Open the Communité Personal Settings page.
2. Click the Address Book link at the top of the Personal Settings page.
3. In the Personal Groups area, highlight the personal group you want to edit and click Modify. The Create / Modify Group page opens.
4. Optionally edit the name or number of the group.
5. To add contacts or other Communité members to the personal group, click Add Members and choose which members to add.
6. To delete contacts or Communité members from the personal group, click the Delete link next to the member you want to remove.
7. Click Save.

Delete a Personal Group

1. Open the Communité Personal Settings page.
2. Click the Address Book link at the top of the Personal Settings page.
3. In the Personal Groups area, highlight the personal group you want to delete.
4. Click Delete.
Creating and managing contacts

Communité Personal Contacts allow you to add non-Communité users to Communité in order to dial personal contacts and add them to personal groups. After you create personal contacts, you can add them to any of your personal groups from the Communité Personal Settings page or the telephone.

You can add non-Communité users as contacts from the Personal Contacts section of the Address Book, as shown on page 55.

Create a Personal Contact

1. Open the Communité Personal Settings page.
2. Click the Address Book link at the top of the Personal Settings page.
3. To add a personal contact:
   - In the Personal Contacts area, click Create New.
   - Add the first and last name of the contact.
   - Click the arrow next to the Email drop down menu, choose the contact’s email type, and enter the contact’s email address.
   - Enter the contact’s phone and fax number.
   - Click Save. Or click Save & Add Another to enter another contact.

Edit a Personal Contact

1. Open the Communité Personal Settings page.
2. Click the Address Book link at the top of the Personal Settings page.
3. In the Personal Contacts area, click the last name of the personal contact you want to edit.
4. From the Edit A Contact page, you can change a name, email address, or other properties.
5. Click Save to apply your changes. Or click Save & Next Contact to edit another contact.

Delete a Personal Contact

1. Open the Communité Personal Settings page.
2. Click the Address Book link at the top of the Personal Settings page.
3. In the Personal Contacts area, click Delete next to the personal contact you want to remove.
Searching for users in the directory

The Directory page shows you how to search for other Communité users, or users with a particular status. This is a useful tool to help locate phone numbers, email, and statuses of other users.

On the Directory page, you can search for other Communité users, or users with a particular status.
Managing your Personal Settings

Search for a Communité User in the User Directory

1. Open the Communité Personal Settings page.

2. Click the Directory link at the top of the Personal Settings page.

3. To search for other Communité users, type the user’s last name in the Last Name field, or type the user’s first name in the First Name field. You can also search by telephone number, fax number, or email address.

4. Click Search. By default, Communité returns the first 30 matches, and provides the user’s phone number, fax number, status, and email address.

   Only your administrator can change the default number of matches returned.

Search for Communité Users with a Specific Status

1. Open the Communité Personal Settings page.

2. Click the Directory link at the top of the Personal Settings page.

3. Place a checkmark in the Status box, then use the drop down menu to choose the status whose members you want to find.

4. Click Search. By default, Communité returns the first 30 matches, and provides the user’s phone number, fax number, status, and email address.

   Only your administrator can change the default number of matches returned.
Working with personal settings

This section provides procedures for common user configuration tasks that you might need to perform using Communité.

On the Settings page, you can:

- Set up Personal Numbers
- Define Follow Me Settings
- Set up your Forward Fax number
- Change your Passcode
- Set up Phone Menu Options

On the Settings page, you can configure several personal settings, including personal numbers, forward and follow me numbers, fax forwarding, passcode, and phone menu options.
Managing your Personal Settings

Understanding personal numbers
The Personal Numbers link allows you to set up Forward and Follow Me phone numbers to which you want Community to route faxes and telephone calls.

Set up your Personal Numbers

1. Open the Community Personal Settings page and click the Settings link.

2. Click the Personal Numbers link located under Settings on the left side of the window.

3. Click Add Number and create your Personal Number:
   - In the Phone Number column, enter the phone number without the hyphen.
   - In the Description column, type a description of the number; for example, Home.
   - To prevent an unauthorized person from answering your faxes and calls, place a checkmark in the Require Passcode box.
   - When you enable the Forward or Follow Me features, the system prompts anyone answering your faxes and calls to enter your Community passcode.
   - In the Timeout column, set the Follow Me Timeout. Base the timeout on how many seconds you want the system to wait before trying to locate you at the next number on your list. If you do not enter a timeout, the system defaults to 30 seconds.

This feature is helpful for phones that take longer to connect, such as cell phones. However, you may need to adjust the Timeout setting, depending how quickly the cell phone voicemail picks up the call or whether or not you want it to go to the cell phone voicemail. For example, a timeout setting of 45 seconds may go to the cell phone voicemail, but a setting of 30 seconds may return to Community’s Forward or Follow Me sessions.

4. Click Save.
Edit or delete your Personal Numbers

1. Open the Communité Personal Settings page and click the **Settings** link.

2. Click the **Personal Numbers** link located under **Settings** on the left side of the window.

3. To edit a personal number, place the cursor in the field you want to change. Make the change and click **Save** to process the change.

4. To delete the entire entry in telephone table, click the **Delete** link at the end of the entry.
Understanding Follow Me services

The Follow Me feature enables you to have all your calls routed to a specific list of phone numbers. Follow Me services provide more sophisticated management of calls when users are not at their desks.

Communité dials a set of numbers you define to locate you if your Status setting or rule is configured to "Follow Me."

You can set up a Follow Me rule for a variety of conditions. For more information on creating Follow Me rules, see Creating and Managing Interaction Rules on page 50.

Define your Follow Me phone numbers

1. Open the Communité Personal Settings page and click the Settings link.
2. Click the Follow Me Settings link located under Settings on the left side of the window.
3. To require users to record their names when Communité activates the Follow Me feature, place a checkmark in the Yes, I want callers to be prompted to record their names when the Follow Me feature is activated box.
4. Set up your Follow Me feature:
   - In the Follow Me List area, click Add To List.
   - In the Follow Me List column, from the drop down menu choose a phone number to route your calls when your current status is set to Follow Me.
5. Repeat Step 4 for as many Follow Me numbers as you want to include.
6. Click Save.
Working with Forward Fax

Use this page to set up your forwarding options for faxes.

1. Open the Communité Personal Settings page and click the Settings link.

2. Click the Forward Fax link located under Settings on the left side of the window.

3. To turn on fax forwarding, place a checkmark in the Enable Forward Fax box.

4. In the Forward Fax Number box, enter the telephone number to which you want Communité to forward your faxes.

5. Click Save.

Configuring Options in the Phone Menu

Phone menu options allow you to set up notification options available to you when you are away from your desk or are unavailable.

When you leave your office or are unavailable, Communité can send an alert to any telephone number, including your pager, if you receive voicemails or faxes.

If you set up Communité to send an alert to your pager, you will receive a text message that includes the remote telephone number and the date and time of the call.

The Phone Menu option also allows you to customize available features you hear when you dial into the telephone interface, such as how messages are read back to you, which messages are read first, and what announcements you receive when you dial in.

Set up your notification options

1. Open the Communité Personal Settings page and click the Settings link.

2. Click the Phone Menu link located under Settings on the left side of the window.

3. Choose your notification method:
   - Under Notification, click the dropdown menu and choose to be notified by telephone or by pager.
   - In the Number field, enter the telephone or pager number you want Communité to use to alert you of a voicemail and/or fax.
4 Choose when you want to receive an alert:

- To be notified if you receive a voicemail message, check the **Notify on new Voicemail** box.
- To be notified if you receive a fax, check the **Notify on new Fax** box.

5 Click **Save**.

---

### Set up your telephone prompts

1. Open the Communité Personal Settings page and click the **Settings** link.

2. Click the **Phone Menu** link located under **Settings** on the left side of the window.

3. In the **Prompts** area, choose how you want Communité to announce your settings when you log into the system:
   - To direct Communité to announce your extension to you when you log in, place a checkmark in the **Read Mailbox Confirmation** box.
   - To direct Communité to announce your current status when you log in, place a checkmark in the **Play Status Prompt when logging into system** box.

---

4. To direct Communité to read messages marked with a priority to you first, regardless of the time the message was sent, place a checkbox in the **Read Priority Messages First** box.

5. Define the way you want the system to play and sort your messages back to you when you retrieve them:
   - To play your messages back in verbose mode, click the **Verbose Mode** radio button.
     
     Verbose mode, typically recommended for the inexperienced user or the user who doesn't use the telephone interface as often, presents you with more spoken prompts from the system.
   - To play your messages back to you in brief mode, click the **Brief Mode** radio button.
     
     Brief mode, recommended for the user experienced with the telephone interface, provides less prompting from the system.
• To play your messages back to you in the order of oldest to newest, click the **Oldest First** radio button.

• To play your messages back to you in the order of newest to oldest, click the **Newest First** radio button.

6 Choose which types of new messages you want Communité to play when you log into the system:

• To play new voicemail messages, place a checkmark in the **Voicemail** box.
• To play new faxes, place a checkmark in the **Fax** box.
• To play new email messages, place a checkmark in the **Email** box.

7 Choose which types of saved messages you want Communité to play when you log into the system:

• To play saved voicemail messages, place a checkmark in the **Voicemail** box.
• To play saved faxes, place a checkmark in the **Fax** box.
• To play saved email messages, place a checkmark in the **Email** box.

### Changing Your Passcode

Use this page to change the Passcode you use for telephone access.

1. Open the Communité Personal Settings page and click the **Settings** link.

2. Click the **Passcode** link located under **Settings** on the left side of the window.

3. In the **Old Passcode** field, enter your old passcode.

4. In the **New Passcode** field, enter your new passcode. Valid codes are numeric (0-9) and are typically limited to ten. See your administrator if you have questions on the minimum passcode length.

5. In the **Confirm Passcode** field, retype the new passcode.

6. Click **OK**.
Index

ACCESS ANOTHER MAILBOX FOLDER MENU ........................................... 45

ACCESSING

Another mailbox folder menu ........................................... 45
Calendar Access menu ............................................... 44
mailbox folders ...................................................... 45
Manage Email menu 27, 28, 29, 30, 31, 32, 34, 44, 46
Manage Faxes menu ............................................... 23, 24
Manage Voice Messages menu ....................................... 9
Personal Options menu 34, 35, 36, 37, 38, 39, 40, 41, 42

ACTIVATING RULES ......................................................... 37

ADDING

call rules ................................................................. 52
personal contacts .................................................... 58
ADDRESS BOOK ................................................................. $6, 58, 59, 60
ADMINISTRATIVE OPTIONS

changing your .............................................................. 39
configure ................................................................. 40, 41
forwarding ................................................................. 38
managing ................................................................. 38
play current ............................................................... 40
play mailbox ............................................................... 40
playing high ............................................................... 40
setting ....................................................................... 39
sorting ....................................................................... 39
ATTACHING

voice comments ............................................................. 10, 29
AVAILABLE MESSAGE TYPES .............................................. 40
BRIEF MODE ................................................................. 39
CALENDAR ACCESS MENU .................................................. 44
CALL RULES ................................................................. 50
adding ....................................................................... 52
changing ................................................................. 53
deleting ................................................................. 53
CALLS

routing ................................................................. 34, 36
CHANGING

call rules ................................................................. 53
fax rules ................................................................. 54
Index

Forward and Follow Me numbers... 63
passcode............................... 39
personal contacts.................... 58
personal groups...................... 57
CHOOSING MESSAGE TYPES......... 40, 41
COMMUNITÉ PERSONAL SETTINGS..... 37
CREATING
call rules................................ 52
Forward and Follow Me numbers... 64
personal contacts.................... 58
personal groups...................... 38, 56
prompts ................................ 37
CREATING VOICEMAIL............... 31, 32
CURRENT STATUS GREETING......... 40
CUSTOMIZING COMMUNITÉ.......... 50, 61
DEACTIVATING RULES............... 37
DELETING
call rules............................... 53
call rules............................... 53
effect.......................... 10, 28
effect.......................... 10, 28
effect.......................... 11, 28
effect.......................... 11, 28
effect.......................... 11
DELETING
email................................. 28
effect.......................... 10, 28
effect.......................... 10, 28
effect.......................... 11, 28
effect.......................... 11, 28
effect.......................... 11
EDITING
call rules................................ 53
fax rules............................... 54
Forward and Follow Me numbers 63
passcode............................... 39
personal contacts.................... 58
personal groups...................... 57
EMAIL
accessing by phone.............. 27, 44, 46
deleting................................ 28
forwarding............................ 28
listening to..................... 27, 44, 46
saving................................. 27
skipping............................... 29
ENVELOPE INFORMATION
playing.............................. 13, 24, 30
FAX FORWARDED FEATURE........ 62
FAX OPTIONS........................ 38
FAX RULES........................... 50
changing............................... 54
deleting................................. 54
FAXES................................. 38
# Index

<table>
<thead>
<tr>
<th>Accessing by Phone</th>
<th>Forwarding</th>
<th>Listening to</th>
<th>Managing by Phone</th>
<th>Replying</th>
<th>Skipping</th>
</tr>
</thead>
<tbody>
<tr>
<td>23</td>
<td>38</td>
<td>23</td>
<td>23, 31</td>
<td>26</td>
<td>24</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Greeting</th>
<th>Help</th>
<th>Interactivity Rules</th>
<th>Managing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Status</td>
<td>Mailbox</td>
<td></td>
<td>Deleted Messages</td>
</tr>
<tr>
<td>40</td>
<td>40</td>
<td>50</td>
<td>43</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Forwarding</th>
<th>Listening to</th>
<th>Email</th>
<th>Faxes</th>
<th>Voicemail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email</td>
<td>Faxes</td>
<td>Voicemail</td>
<td></td>
<td></td>
</tr>
<tr>
<td>28, 29</td>
<td>38</td>
<td>10, 11</td>
<td>23</td>
<td>9</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Forwarding Calls and Faxes</th>
<th>Getting Started</th>
</tr>
</thead>
<tbody>
<tr>
<td>3, 64</td>
<td>6, 7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Manage Email Menu</th>
<th>Manage Faxes Menu</th>
<th>Manage Voice Messages Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>27, 28, 29, 30</td>
<td>23, 24</td>
<td>9</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrative Options</td>
</tr>
<tr>
<td>38, 39, 40, 41, 42</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Messages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Saved Types</td>
</tr>
<tr>
<td>41</td>
</tr>
</tbody>
</table>
Index

managing..............................37
recording............................37
RECORDING PROMPTS..............37
REMOVING
call rules............................53
fax rules.............................54
Forward and Follow Me numbers63
personal contacts....................58
personal groups......................57
REPLAYING
voicemail............................12
REPLYING
to faxes..............................26
to voicemail........................12
RESPONDING TO
faxes.................................26
voicemail............................12
REVIEWING
other Communité users56, 58, 59,
60
personal contact’s properties.....57
ROUTING
calls..................................63 64
calls and faxes......................53 64
faxes..................................62 63 64
telephone calls......................62
ROUTING CALLS.......................34 36
RULES..................................50
RULES ACTIVATING AND DEACTIVATING..37
SAVED AVAILABLE MESSAGE TYPES.....41
SAVING
email..................................27
voicemail..............................10
SEARCHING............................56 60
SENDING VOICEMAIL...............31 32
SETTING
status.................................35 49
SETTING PRIORITY
for email..............................29
for voicemail........................11
SETTING UP
available message types .........40
available saved message types ..41
Follow Me.............................36
Follow Me Follow Me calls
routing routing calls .............36
Forward and Follow Me numbers64
SETTING UP MAILBOXES ..........7
SKIPPING
email.................................29
faxes.................................24
<table>
<thead>
<tr>
<th>Topic</th>
<th>Pages</th>
</tr>
</thead>
<tbody>
<tr>
<td>voicemail</td>
<td>11</td>
</tr>
<tr>
<td>SORTING MESSAGES</td>
<td>39</td>
</tr>
<tr>
<td>STATUS</td>
<td></td>
</tr>
<tr>
<td>setting</td>
<td>35 49</td>
</tr>
<tr>
<td>STATUS GREETING</td>
<td>40</td>
</tr>
<tr>
<td>SUBFOLDERS</td>
<td>45</td>
</tr>
<tr>
<td>TEXT MESSAGES</td>
<td></td>
</tr>
<tr>
<td>playing</td>
<td>13</td>
</tr>
<tr>
<td>TUTORIAL</td>
<td>6</td>
</tr>
<tr>
<td>USER DIRECTORY</td>
<td>56 60</td>
</tr>
<tr>
<td>VERBOSE MODE</td>
<td>39</td>
</tr>
<tr>
<td>VIEWING</td>
<td></td>
</tr>
<tr>
<td>other Communité users</td>
<td>56 58 59 60</td>
</tr>
<tr>
<td>personal contact's properties</td>
<td>57</td>
</tr>
<tr>
<td>personal groups</td>
<td>38</td>
</tr>
<tr>
<td>VOICE COMMENTS</td>
<td>10 29</td>
</tr>
<tr>
<td>VOICE MAIL</td>
<td>10</td>
</tr>
<tr>
<td>VOLUME MAIL</td>
<td></td>
</tr>
<tr>
<td>accessing by phone</td>
<td>9</td>
</tr>
<tr>
<td>creating</td>
<td>31 32</td>
</tr>
<tr>
<td>deleting</td>
<td>10 13</td>
</tr>
<tr>
<td>forwarding</td>
<td>10 11</td>
</tr>
<tr>
<td>listening to</td>
<td>9</td>
</tr>
<tr>
<td>managing by phone</td>
<td>9</td>
</tr>
<tr>
<td>replaying</td>
<td>12</td>
</tr>
<tr>
<td>replying</td>
<td>12</td>
</tr>
<tr>
<td>saving</td>
<td>10</td>
</tr>
<tr>
<td>sending</td>
<td>31 32</td>
</tr>
<tr>
<td>skipping</td>
<td>11</td>
</tr>
<tr>
<td>VOICEMAIL GREETING</td>
<td>37</td>
</tr>
<tr>
<td>VOICEMAIL RULES</td>
<td>50</td>
</tr>
</tbody>
</table>